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§ 1.1 SANArray M anager # B

SANArray Manager A i P A3 4344 i :

=2 Globe Array Manager Server (GAM)
=2 SANArray Manager Client

FLEThRE

i SANArray Manager Client o —/NM LG BRI A ) T D) BRI “RAID Assist”
A DMRZE D) SE A AL, P R SR — e iy ) 8, RAID Assist )
SERFEAR IC B A

WHEThRE

Globe Array Manager Server WCHERLHEFEF RS BANBETA HI G DL ROX L5 Bk
%45 SANArray Manager Client, SANArray Manager Client ¥ 35 HU1 45 B in LLAH 2350 #r
I B 1 T X BRI K o A9 A A I 21 ) A TR B = e R A7 7
I, FIRAEER D Bon k. FH PR DABE AR R A — i U BRI, d i
PR . TR A R, R Email B0 AL ST OB A e ARSI S T g
T AR 2% SANArray Manager Client Il 45 2 2 & b 22 200 Y 1 IR 55 .

HPThRe

SANArray Manager Client n] LU i AL LI 2 N RERL BEA A T BRI 4, IX
Yeprudh: MRS FES P IR EEAE AL GBS “Kill” , i “Off-line” #:4F) .
FAREREAL RS, A5 Hot-spare AL W —BUEACLS (BETIRALE) VIUH ARG RS o
XSRS T Globe Array Manager Server )i & 58 8.

§ 1.2 REFEKR

SANArray Manager /&% Client/Server {411, Globe Array Manager Server %21/l
528 b RSS2 SHEELMEY| C 4% ) , SANArray Manager Client 22388 Wi 11 % )
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SANArray Manager & Bl 1125 ) 5 SANArray Manager Client 244t g 7 Sk e
YT PSR R E R S

AR FRK:

= 80486 LA FALFEZSK) PCHL, %/ AM HINAE, EEUE #5241 A0 FE 2e A1 16M LA
RINAT

2 R PR ISR RN Y 2 PR

2 Globe Array Manager Server eIk I, RN IR SS&5A0H] O HRAE RS
Globe Array Manager Server ‘%3,

= IR 1.44M AR S A

= /b 8M BRG], X 16M DAL

= Rbr. B

= /b 800X600 M1 R7s A, L] 1024X768 1 s 7 % ;

= Windows Me. Windows 2000, WindowsNT. Windows 95/98 #1FE &%t ;
= 2%z TCPIP Bpifle

B R K

= AdIERE . BB,
=2 ZFF MAPI 8, SMTP il i S AR G A Can Microsoft Outlook) .
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B2E PR

AR P LR RS EH . P AE%%% SANArray Manager Client 1), AT L
] I e P 2225 Globe Array Manager Server  (GMA) , AibiX i B AU S FF . 2
% GMA, {EJH5) SANArray Manager Client DLTZS 3 H GMA R6HFHEZE SRR 58 2h &

S

§ 2.1 XFHHEBIERSA

SANArray Manager Client SCRFUT T I JURIMEEAE R4

NNNNN

WindowsMe
Windows 2000
Windows NT
Windows 95
Windows 98

§ 2.2 SANArray Manager ClientZe3

SANArray Manager 1230 e 4 IRERAVE R ek kil o3 1), SCRF Windows NT R 414
FESCAAEIAE WINNT B3t F, Windows 2000 54: K [IUAEAE WIN2K H 5% F -

TRGLRE:

1. RIS AE RS BIEI SANArray Manage ‘22235 SO H 5% s
2. AT Setup.exe, ¥ LR Eh NS,
3. —BEfal, gl Welcome XFUEHE, U REAT R, s Next 4k4L40%%, Cancd B

2R

Welcome to the SAMAray bManager ProFibre Setup
program. Thiz program will inztall SaHAray Manager
= ProFibre on wour conputer.

It iz gtrongly recommended that wou exit allWindows programs
befare running this S etup program.

Click Cancel to quit Setup and then close any programs you
hawve running. Click Mest to continue with the Setup program.

WA RMING: Thiz program iz protected by copyright law and
international treaties,

Unauthorized reproduction or distribution of this program, or ang
portion af it, may result in zevere civil and criminal penalties, and
will be prosecuted to the maxinun extent pozzsible under law.

x|

Cancel
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4. HHRIURAEAZEIERE S, el Yes B2 VR 4k LU et . an ik FE No,
PR¥s 211 SANArray Manage 1223 ;

Software License Agreement il

Fleaze read the following Licenze Agreement. Press the PAGE DOWHN key to see
the rest of the agreement.

LICEMSE AGREEMEMT i’

|BM International Program License Agreement
Fart 1 - General Terms

FLEASE READ THIS AGREEMENT CAREFULLY BEFORE USING THE PROGRAM.
[BM WILL OMLY LICERSE THE PROGRAM TO *0OU IF %0U FIRST ACCEPT THE
TERMS OF THIS AGREEMENT BY USING THE PROGRAM. [F 0L DO MOT AGREE
TO THE TERMS OF THIS AGREEMENT, PROMPTLY MOTIFY THE PROYIDER OF
THE PROGRAM AMD REGQUEST & REFUMD OF THE AMOUNT YOU PAID.

The Frogram iz owned by International Buzsines: Machines Corporation or one of itz LI

Do you accept all the terms of the preceding Licenze agreement? If you choose Mo, Setup
will cloze, Toinstall SaMAray Manager ProFibre, you must accept thiz agreement.

< Back res Mo |

5. I TEHE AT &I FTs o 3K HUAT DU 5 Sk e e 41

Select Components ) x|

Select the components you want to install, clear the components
wau da nat want ba install

LComponents

2180 K

Dezcription

Fequires that the SARNAray Manager
FroFibre Server component be inztalled on

thiz or zome other network attached

compuber,
Space Required: E296 K
Space Avalable: Z27E188 K

< Back | Mest » Cancel |

6. Aiii SANArray Manager Client R f/ME, 223 SANArray Manager Client %1

Apx
TEIEFE225 SANArray Manager Client [ [R] 4t n] LAk #8224 GAM Server;
7. EFE Next BB LHELH,
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BIE BEhfRT

A A RS 4] 2 5 SANArray Manager Client BL A 3 5 SANArray Manager Client i £
A TAERR B )5 oI B St .

§3.1 HEATHE

1444 SANArray Manager Client (5 0L EEsin—ANH ™ 4424 gamroot, FHIR T4 24 51
R o

§ 3.2 SANArray Manager /B 3)

SANArray Manager Client #4382 1l #5225 )5 8)) Globe Array Manager (GMA) J5 &5
B, AR 2% GAM G, REEHAZIEZ) GAM kg4t

GlobeArray Manager (GAM) JAZf
Globe Array Manager Server  (GMA) BAAE L — MRS AR SCHARAE RGE P 2244 )
BAERZ NG HEHB).

SANArray Manager (SAM) JE3)
f£ Windows Me. Windows 2000, Windows NT. Windows95. Windows98 F, =] LT
Start->Programs->IBM SANArray Manager ProFibre Client 3K 5303 i 4. g
7EJA 8T, SANArray Manager Client Hs e XRS5 AR IR SS 4%, K3t “Define
Server Groups” X URHE, IR EIFR, 155508 X MIRGS AR ok 7 28 B e g%
PRSI B MRS A Cay LLUE RS54 1 1P ik, o n] LU RS EALA D , #%“OK”
HEN

Define Server Groups llil

—Server Groups ————————— —SErvers

WORKGROLP wiSkserver
Discovered

Add Remove Add | Remove |

Cancel |




I A8 SureFibre &7 B SANArray

§ 3.2 SANArray Manager Clientiz4T 1

SANArray Manager Client iz47 5t 1= 22t SANArray Manager % 1. Global Status View
% 1 F1 Log Information View & 1418, 1 R FTR:

£ Do 1 112
ek O chr 11k 114
ol Db 1igk 116
ol 0w 1igk 118
i O dr 1 gk 120
e O b ik 1
ol 0w ik 125

ct 3w Qigk 33
cit 0 e it 7
ol 1 bgdrec
ot 0wt 0k 25
it 0 bgdr: il

EEREASEEREES

SANArray Manager & K

#1 A HAT AR, AT 2 AT

#2 THF TEARE LA B bR X 2 s vp g F IR LA D g

#3 RS ALk ERE RS EEAL, el LU “All Server” BT T IR 25 2%
#4 FEHISE EHIEARR (C-0,C-1) FiHlgsZsA (DACIBOFL. DACFFX %) .

Global Status View & 1
#5 KhrRs DB IEAEIZTT GAM RS 4%, Ebral LR 7R

= RS Ee 1P kB L4

= RS FIZATIERE RS (2000=Window 2000; NT=WindowsNT; 4&) ;

2 RS EIEATIRE (SHOARTHIER TE, SHORRIERESER, T X HERARE
IEH AR, R 765 RAID #ZEHI#s, RS2 EH N Bon il e i)

= EBAERS YR L DAC #ildebr g M HIas i PIRESTRRIT: S OIEs, Wi
FEER, 7 XERIR AR TR .

#6 ErRRIZIT GAM RS, HEREFETIZRS S,

Log Information View & O

#7 HEGENEE L, & ATRR RIS TR P gHE R PR,
A, XL BT GAM S5 A A8 A b s R i s R ORI
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PATE SHE

A FEA AN SR B GAM RSS2 Wl it SR RAID #5hi FlC &5 B E IR A7
ZHCE IR RAID #1235 &, anfl BRI S RAID it .

§4.1 %%

RO BB FEA A BRI, 17 Je I8 B GAM IR . X W[ LLE SANArray
Manager #F il Administration->Sign On 28] iR ARt Global Status View % [+
MR45 2 bR, RGeS A iR 16 SO T AE

signon 2| x|
Server: quﬂkserver
U=ername: Igamru:u:lt
Pazsword: ||

v Remember password for this session

Sign-on I Cancel

N P14 gamroot M Y, s “Sign On” #4415 53k SANArray  Manager 1)/ FHL7
Tl

§ 4.2 BB ARFEAM 55

4.2.1 iSRS 2B MRE a4

LS54 Administration-> Define Server Group #1771 Define Server Groups #£37, 3t
H NI UEHE (ISR AEI21T SANArray Manager JX1FI RGERAT 2 S5 as k2, Xk
HEXs2x A s ), AEXRHEAE T FAT TR LLoE X H RS S i REZ Ik 55 25 » Define
Server Groups XJ i HE U1 T B s :
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Define Server Groups e b
—Server Groups ————————— —SErvers
WORKGROLP weeSkserver
Discovered
Add Remove Add | Remove |

Cancel |

1. 7E Server Groups #9757 Add 241 ;
2. FEFRH ORI E sh g A e PR S5 AR AL ) A4 R 5
3. s OK, Hrfrdlcausin.

4.2.2 ININRS 2R DR & A iEA

7t Define Server Groups X[ HENT, 7E Server Groups 2% HL fiiliid s — N EEAL, st nl LA

AL IR 555 <

1. 7 Server £ i Add 1441

2. TEBH DO EEHE TP N BN RS54 16 1P bk, 7F Windows R4 Nk nl LU T
LA RAE

3. Al OK, TR S #e BEC IS I B0 5 1 IR 45 A 4L 5

4. WRTLRINE 2 RS, rTLAVES 1-3 85

5. FTHEAEHRERUG, 1E Define Server Groups X 1 AHE 1 it OK, Bl 58 RS I AE .

§ 4.3 FFERAIDIEHIREER R

e R s il File>Save Configuration, HEATH1 R FERAE

1. 7F Save Configuration XJiGHEHT, i NZLLRAT RAID £ il 2 Ac & A5 B 1 S0 445

2. fiih “Save” fRAFICE SO

3 MR TXEEB UG, MEKSRN AR E, T File>Open

Configuration FT H-ORAE I L E SR KR BLE -

§ 4.4 BEFRAI DI I L B SCAF

PESEHRE R il File>Open Configuration, #E4700 R IHEAE:
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1. 7 Open Configuration X TEHE T, &5 75 BLke 2k 1) e 1 S0
2. fiili “Open” FTIFE B E SC, SIS 280 2 BT/ I 2 25 6 R ATE 5

® Exizting configuration will e changed

If vou wwant to proceed, confirm by typing the word YES: Ive3|

Ok I Cancel |

3 QSR BTG E SO M B o T RAID s DI E R, FA YES, w
i OK ik, )44 Cancel HUH .

§ 4.5 iIZ4TRAID Assist

RAID Assist /& SANArray Manager & B EAC & RAID WAL MRS — AN IR F . 1%
DhRedefit 7 A B RAID BEFIIZ F1J5 30, RAID Assist —/M ] HL #4802 Auto
Configuration %3, Auto Configuration 37 B[1¥ i F f G e & le— 4K H RAIDS K
(i I8 4R AL ; Assist Configuration JKEIJUE b F 7 v i — 46 B B2 40 f5 ROk e At
FE%1; Manual Configuration JEIHEALH 7 F T HIFEFECE, A as LUN rmt

451 #ARAID Assist

af LLE S R Administration->RAID Assist 50& T HA%[F) RAID Assist EFridi A
RAID Assist ##/E 51, #AJ5, RAID Assist #<: B~ “Welcome” % 11, Wi R KT
TR

Feloome to RAID Assist!

RAID As=ist allows you to set up new
oonfigurations, add logical drives to
existing configurations, and expand the
mpnuit‘]r t_:-:f_ ezlﬂim arrays. To get

Crenins wn eplissdl confipurslicn using Im
sll wemalable drives valh sinassl user . -3

Rt
CIEII.IE or modifyes s confl poralion

using & slep-by-slep, guesiion and
anwar Frvmel

mnbed ComEiparwtion,

Crealas or sodifies s confl poralion
asing ondy informalion peovided by the

TR

1E RAID Assist [t “Welcome” SHEHES, 44 LR JUREI

10
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4.5.2 Auto Configuration
M Auto Configuration #%411, K43 # i Auto Configuration XHiGHE, 41~ E Fis:

Automatic Configuration 2x|

—Diata Cwerwrite Method

Create a neww configuration. If there is an existing configuration, it Mewy Configuration |
will be oversritten and all data will be lost.

— Diata Retain Method
Litilize the remaining available space in an existing array, or create

& newy array wsing unconfigured disk drives. Existing data will not
be affected by this process.

E:xpand the capacity of an existing array. Existing data will not be Expand Array |
aftected by this process.

Cancel |

Auto Configuration $2 441~ JLANIETR :

= New Configuration Ml & CL & A7 7E I BC & DL ARER: B Eds, s —ASHaid
B, RISy I B TR0 G HE -

Aulormmatie Conbigurstson, S ew ConBigur slson weiksnrenr, Comtroler-00

1 Walcoma 2 Pinizh |

RAID Assist has completed the
manFimreat ion [

Ten oum viww dwiwils of s oonbigeratien br slicking Lbe
Pyl . bt LIE vew we sabisbied miih the

b paration o dubised belew, wlick \be “hpply” bwbien e

IE veu wizh is redefioe tbe cmEigarwtion oo is b " Felowss'
pupe weed pelect * Bavesl ComEigpmration .

Crnfiguraiion Sussury.

Fhysical = Al Logieal L |
Fhyrsical DoMEADG B Logical . ETIECE WE
L3 = | EALD . EMD S
Stripe B Cache Line B

Bkl e wvite e Inutind L T

Gl | _ fmeek | aeelr | twsa |

s “Apply” , BRAREAR: ATLARGE Detail 24, WonFCE R TEAE L, W HIE
I

11
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Automatic Configuration (wqdkserver, Controller-0)

Details |
Dizk Arrays (ME):

Logical Drivez (ME):

Al
312408 = 0-3 0-50= 0-7lr= 09— 1-0jr—= 1.2
34712

= 18

Unused Disk Drives (ME):

(34712
== 01

stz sz s s s st s s 0 [=]27re3%6 R4ID 5
] — l4|— 16

Close I

= Add Logical Driver IS ISR, 1K HL 0 2 /D A EAE — N B L I8 AR AR I

HAFAEAR ST BC A HT 154

= Expand Array i S INREAE,  FOBRRE RO A5 AL S AN REE NS I A

4.5.3 Assist Configuration

7F RAID Assist [ Welcome” 5% % 111 7 il Assist Configuration #2411, K54 i Assist

Configuration X 1iiHE. 1T K Frx:

Assisted Configuration

21

—Data Crverwerite Method

Creste a newy configuration, If there is an existing configurstion, it
weill be overseritten and all data will be lost,

—Data Retain Method

Liilize the remaining available space inan existing array, or creste
a nevy array using unconfigured disk drives, Existing data will not
be affected by this process.

Expand the capacity of an existing array. Existing data will not ke
affected by this process.

Add Logical Drive

Cancel

Expand Array |

Assist Configuration #2411~ JLAN T :

= New Configuration Il £ 28 47 75 I G B A S Bt it , 08— 4SBT

12
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B, Iy LR B P TEAE

Assisted Configuration/New Configuration (test, Controller-0) il

I Weleome 2. Fault Tolerance |3, RATD Level| 4. Logiecal Drives | 5.0ptimization | 6. Finisk |

Fault tolerance will n=ze part of your storage capacity to
store redundant data. If a driwe fails, lost data can be
reconstructed using the redundant data stored on other

Fault Tolerance

Do you want Fault " Tes o

Faid Leuvel

Logical Orives

Dptimization Selecting a hot spare will reserwe a driwe to
Finizh antomatically replace a failed driwe in a famlt tolerant
Do you want a Hot Spare? ( Tes * Ho
< Back Hext > Cancel

[F] % 2 75 48 Fault Tolerance flJg: 75 7 22 ' Hot Spare 7% 44, 8% 5 Aiihi RAID Leve
FRZEEN RAID 0 FIBeE, W FEFR:

Assisted Configuration,/MNew Configuration (test, Controller-0) 5[

1. Weleome | 2. Fault Telerance 3. RAID Lewel |4. Logical Driwves I 5.Dptimization| E.Finishl

Tata striping, no fault tolerance (RATD 0) improwes
performance by striping data across two or more physical

Ho data striping, no fault tolerance [JBOD) configures a

Fault Talerance single physical dewice on the controller.

Fiaid Lewel

Logical Drives i~ Data striping, no fault tolerance (RATID 0)

Optimization {* Ho data striping, no fault toleramce (JBOE

Finish

{ Back Fext > Cancel

[B] 248 H RAID 0 3 2 AMEAEAT RAID & (JBOD), #E AL B4 (¥ & it , 4n R &
Fios

13
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Assisted Configuration/New Configuration (test, Controller-0) il

I Weleome | 2. Fault Tolerance | 3. EAID Levsl 4. Logicsl Drives |5 Optimization | 6. Finisk |

Azzisted configuration will create logical driwes from the
capacity and number of logical driwes you zpecify.

Fault Tolerance
How many logical drives do you want to I 3:

How much capacity do you want to IIDD % ISQTlED ME

Faid Level

Logical Drives

Clptimization

e

Finizh

Selecting initialize will initialize all logical driwes.

Do you want to initialize logical (¥ Yes " Ho

< Back Hext > Cancel

i N AR RE SR I RO AL T K 7, RN [ A A R 00 SR AT IR Ak
Bt WENZEREVERERCE S, W TR ETR:

Assisted Configuration/New Configuration (test, Controller-0) il

1. Weleome | 2. Fault Tolerance | 3. EATD Level| 4. Logieal Drives 5.Optimization |§. Fimisk |

If wour host system has an Uninterruptable Fower Supply
(UFS), or your controller hasz a Battery Baeclap Unit (EEU),
write cache may be enabled for added performance.

Fault Tolerance

¥ ;irite cache enabled (write bhack):

Fiaid Level ) ) )
(" Write cache disabled (write through)
Logical Drives

Clptimization
You can set stripe size and cache line size best suited
for wour system. They will be applicable for each =y=tem

Stripe sire: |E|4 KB 7'
Cache line IEHl KB 'I

Finizh

< Back | Hext > I Cancel |

e B SR M DS N A 247, DAL B B RN A R/, BE B 58
BEAZF Finish FHil, 2 BoRB B —25 8, s “Apply” #8l, BHABCEAR: B
B AEAE B AT LA ity Detail $5HIKRIRE, SRR R 40T B s

14
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Assisted Configuration/New Configuration (test, Controller-0)

I.Welcomel 2. Fanlt Tolerancel 3. RaTD Levell 4. Logical Driwes I 5. Optimization B.Finish |

AnanfFimiratian

Fault Tolerance

Faid Level

RAID Assist has completed the

I
Tou can wiew details of the configuration by clicking the
“Details...” button. If wou are satisfied with the
confizuration as defined below, cliclk the "Apply” button to

If you wish to redefine the configuration, go to the *Welcome'
page and select 'Manual Configuration’ .

L

Logical Drives

Ciptimizatian Configuration Summary:

Finish Fhy=ical ;10 Logical ;10
Physical : 347120 ME  Logical © 34T1Z0 ME
Hot 1 o RATD 1 JEOD
Stripe 1 B4 KB Cache line : B4 KB
Enable write o Tes Initial o Yes

Details, .. % Back Apply

x|

= Add Logical Driver ININ—A BRI B DA A D AFAE — AN T PR B

HEIF HAFAEAR 2 FCAE HI R o

= Expand Array i S INREAE, OB RO A5 AL S RGN S I A

Manual Configuration

T LACE RAID IERAEEREAETEAN 4R, HLP T LS 7 i BAT IR G AL P KA OGSO

AT

15
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$oEE ErhiE

AT RIS A0 SANArray Manager & BT A5 B ] A4 2 (0T 3
W& BEREISNICERS S SAYHEBE A HEBA N6 R LI LB % AL

§5.1 FHHEEE

GAM WSMLFT A IEBAE RS 25+ HBA ERIF IS A B & 2 PR DL . 24— nlil
AT R RAE, B R A ST, B IR, fRE MR
o A . XA GAM &% F] SANArray Manager (I35 E. 3 HAE Log
Information Viewer & 1 2 x ok, —ANFifF ] Ge)E T LT JLAN IR

2 BRI BGR H SAN 4%
2 RAID 7RSI RECE SR, W, XU s A R
2 DUk SR BAT s A0 SR R A

Ax

HEBANEC ] SANArray Manager Client F2/7,  DLERE XN i) GAM Ak i AHE .

5.1.1 #TFFLog Information Viewer & 1

— e, FERELETFAIZATIN, Log Information Viewer & 1 B2 HENH T, %% 1 Boni)
SER A& samel.log SCARSCAFH AN EY, ERAT T SANArray Manager &/ P7EIa 1T fe Fhifie
LR FHE R . Sancllog JUg— /M B H &S 4, P AT LAE samelini SO
& s U4

i Log Information Viewer % F#%5CH], ] LLidE IS View-> Log Information Viewer it
TRAT P H AW %% K. Log Information Viewer % [ /s R B 7R :

5 Device hddwsi | Desaipton I s
- 3 erl: 1 Conbrolier i foind 3 A1 12fE5 05
[ya 4 hast A0S 155 el Conbralier i found 3 A1 12 055
el 3 hasy A0S 055 el 1 Ompsl CrindroBers Ensblsd = A1 12N D5
U2 3 baar A0S 055 el Dl Cinbrolisry Enablsd & A1 12 055
| BT baar AL 055 Burary anagamant derve soltuans o 7 A1 12]5 15

B 1ons 4 bast AOIRES S furary management ssree saftwars s, 8 Az 055, . |
[ 1518 4 hast Z0NT1HEES 055 erl: 1 parans (A  Lasbomate rebook counk has chacnged 9 e L INEY Pl
i 1518 4 bast A1 055 etl: O pacamne (ra000  fustemsatic rehoak enunt has charged [ Ju] e LINTY el el
i owra1d 3 bast AO1AES 055 etl: 1 pacamc G100 Uipdisbad partnads status 1 amifizfes 05s
B a9 3 bast AOifioes 0SS etl: 1 pacame (ol 100 Uipdabad pastnacs st 12 AMIzfes 05S
WM 3 hast IS 055 e Ol Ciairalinrd mrberad Maom i3 e L INEY P Pl
B owra 3 bast Aifiates 0SS eel: Cumal Contrallsrs anbarad Msoam 14 AMIzfS 05S
i WAt 3 bast AO1AES 055 etl: 1 pacamc D00 Uindiabad partnads status 15 Amifizfes 05s
I owa9 3 bast AOifiaes 0SS etl: O pacsme (200 Uipdabad pastnacs st 16 AMIZf25 055
| DL} 4 hast ML HES 055 el 1 el L & s P ok o Bt fdnddl 7 A 1S 055
| WSkl 4 bast D01 055 erl ek 1 bgui 0 & v e diak hae b, Fodndl [ [F] 2011225 055

i IR bast PONFIBS 5i5.., et 1 ek Dbat: 1 & neiw e disk has By found 15 20011205 055, X

G VA G A e T LA BOR A
Event ID SR AN BRI AN, FOoRgiERE S B BRARS
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PERAES
Severity HUer o AR BN, w] R Severity A% IR FAR AR
Source KGR S5 A 1P bk ol 184 5

Sourcs Time ~ GAM il B A& AN AR INF ) CER/ T H NN A3 B0

Device Address 5 AHOCH il 8y I IESE(E E s

Description KA AR SO R

Sequence(Seq)  [Al— & Mg ECAR R A FAF T SIS

Local Time SANArray Manager W E] GAM &% i = 4 i i i) C4E/ T H
INE Y BIIRD )

512 I E A HAFEREN

R AR TSR Log Information Viewer & H B R R TEGIAS B, vl LST R i vean
THOLE

7t Log Information Viewer & H H ik ££ 75 LR ITEA{E BG4, Xt “Event ID” B,
Ko ERE D, W EPTR:

EventID: I-1 Sewverity:4 X|
SOUECE I test
DEVICE ADDEESS : etl: O chn: O tgt: 1
DESCEIFTION - A hard disk has been placed
online.

CAUSE: (Could be one or more of the

ebuild Completad.
evice was configured.
armal on—line was done.

EEQUTRED ACTTION:

rl:ll'l.e.

FAH OGRS E0] LAFE B fig e — LB o 71 7 AR B, BRI E SR Event
ID #1 Severity Level, SOURCE, DEVICE ADDRESS, DESCRIPTION 5 Log Information
Viewer & HH Wos i) —FF, HrpEAa o am2:

CAUSE AR R A T R SR
REQUIRED ACTION  fi#kF R B I RIS 71k
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§ 5.2 ¥TH-Controller Views 0

WS A View->Controller View &35 7] LL¥T I Controller View % 11, 41K K Fis:

=000

0 [=_] 20
A=k
|2 ] e
P
=] wa
s ez
(B =] =2
* =] 41

W Encicees

Lagical Drives [MEL

Aa00
A&D
R40S
RaD
RADN
R&D3
AEDS
FLAD el

Tkl Lol Capacdy. JREEEENE
Tolal Pradical Capacit HTIEONE

P A 1A

RN A7 AE I P B A

%5 R M BTZE controller selection A% 52 A H h S A AH 9543 AL
=2
=2
2 PSS E AR R RO, DL R R I 2R

o
Y

N

&

§ 5.3 BREHISER

Tl DLW S R, Administration->Controller Information i&I5aE# T B A% Controller

LA A4 1D,

NE=N

. RAARE

Information & 4537 7T Controller Information % 1, 40T & Fis:

Controller - 0 Information

2l x|
—Dual Controller Status

Fartner Status: Ok
Fault Tolerant :

Hill Partner |
Relinguish Partner |

es

Controller Specific

RAID I FIZ 48 A

Enclosure Bl#x, W nBAREFEFINLAG PR R, PRANAE B AT DO R0 [l brgk

ol : MetearFF
Firmeweare Wersion o 7a5-00
Cache Size . B4 mB
lemory Size : F2mB
Inteligent BBEL : Yes
Host Ports S

Drive Channels 2

Bus Type : Fibre
Bz Width : 1 Bits
Bus Speed ]
Physical Devices 13
Logical Crives 2

Host Connection Information
05 Contraller: 3

Channel: 0
Target: 1]

Port: c1pl
cOp0 cOp1 c1pd clpl
Part ID: o P, 1 i,
Wi SO T c1:
2000 0080e5 119547 2000 0080e5 119547

Controller Options...
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B

A
=
=
=
=
=
=
=
=
=
=
=
=
=
=

=2

ZEE UMDY

P il A A

Firmware fAS5

SEYNGN

WAER D

7747 BBU

P 2% (1) Host i 1%

P25 T 0 20 11 A

P2 i Lo R

TN I i PSR

PR 1 1) A BRI A% P AN S

2 T P )3 B R S 1 N B

HERAE S L ENLEE (HBA £%(H, Channel ID . Target1D)
A% F G0 Al B R IR S

AT A T8 TR DA XU 2R e TRl B A

P25 ) 4% LB Al 42 L 1)ty 1 45, i 11 1D, WWIN

AT RT3 T VAR S AT S 25 B LTS (KOG AL P AR S BERHI A 2

19



